IV. Data Management

Database operations will be covered in this module using Microsoft’s Access software.  This exercise assumes familiarity with the Excel module so you should complete that one first if you haven’t already done so.  This version was written for Access 2000 and works well with Access 2003.  If you’re using Access 2007, refer to the Access Exercise for that version.

Why use a database instead of a spreadsheet?

The underlying structure of a database is a data table (like an Excel spreadsheet) or series of related tables.  The database adds more user-friendly interfaces (forms) between the user and the table and it allows for automated searching, sorting, and summarizing of the data in the tables.  A database is more difficult to set up than a spreadsheet.  The effort required to set it up is best justified when you have large data sets (more than 30-50 subjects), many data items (more than 15-20), or when you will be repeatedly performing tasks like sorting and summarizing the data as they are being accumulated.

	Comparing Databases and Spreadsheets

	Task
	Spreadsheet
	Database

	Set up
	Simple
	More complex

	Data entry
	Tedious and prone to mistakes if too many rows and columns
	Easier and less prone to error

	Error prevention
	Can be done
	Easy to do

	Sorting
	Can be done but is prone to data corruption
	Easy to do, even for complex selection and sorting criteria

	Calculations with or between data fields
	Easy to do
	Can be done but may be more difficult

	Summarizing sorted data (counts, means, etc)
	Fairly easy to do
	More difficult to set up but can be easily repeated as more data are entered


The following exercise can be done by experienced Access users without help.  Less experienced users may require help.  The tasks to be done are typed in italics.  Detailed instructions for each step in the exercise are given in regular typeface.  You can refer to the detailed instructions if they are helpful or you can simply read and respond to the tasks requested in italics.  Online resources are listed at the end of this document.  If you are having problems with this module (it’s been beta tested but it is relatively new), please ask for help: mailto:kathleen.a.kennedy@uth.tmc.edu (individual help available only for students enrolled in the UT-Houston Clinical Research Curriculum or MS in Clinical Research Degree Program).

Create a Database and Import Data

Open the Access program and create a new database.  After opening the program, select “Blank Access database” from the dialog box and click on “OK.”  Name the database “YourLastName-Exercise.mdb” and save it in the folder of your choice.  Import the data from the spreadsheet AccessExercise.xls.  Click on “New” and “Import table” and “OK.”  Find the AccessExercise.xls spreadsheet and select it (You will need to select Microsoft Excel as the Type of file at the bottom of the dialog box).  Click on “Import.”  Click on “next” to accept the first 4 default options. Select “Choose my own primary key” and then select “IDNumber” as the primary key.  This will treat IDNumber as a unique identifier to ensure that the same subject (with the same ID number) cannot be entered into the database twice.  Click on “Next.”  Type in the table name “Subjects” under “Import to table” and then click on “Finish” and then “OK.”

Open the Subjects table in design mode to make modifications to this table.  Select (single click on) the “Subjects” table and then click on “Design” in the menu bar at the top of the dialog box.  Your screen should look like this:
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Select (click on) the IDNumber row.  Change (if necessary) the “Required” entry in the lower table to read “Yes” (you can’t enter a record with this field left blank) and the “Indexed” entry in the lower table to read “Yes (No duplicates).”  To change these entries, click on the selection, then click on the down arrow to the right of the selection to make a change.  Note that “Double” is listed as the Field Size.  We will need to know this later.

Add New Fields to the Database

Add a field named “Complete” to the database.  While still in the Subjects table design window (opened above), use the scroll bar at the right to move to the next blank line in the upper table.  Type in “Complete” under field name and select Text as the field type.  We want to restrict the entries for this field to “Yes” or “No.”  In the lower table, for Validation Rule, type in ““Yes” or “No” or is null.”  (Include the quotation marks around Yes and No to signify that these are text words.)  “Is null” is the Access designation for a blank field.  For Validation Text (the error message you will receive if you violate the validation rule), type in “Enter Yes or No.”  Save the file (Click on “File” and “Save.”)  Answer “No” to the question “Do you want the existing data to be tested with the new rules” because you have no data in the Completed field with the new validation rules.  Close the Subjects table window.

Databases differ from other software programs in that any additions, modifications, or deletions you make to the data are automatically saved.  You don’t need to “Save” the file when you exit the program.  Usually this is an advantage.  If you make mistakes in data entry, however, you can’t go back to the original unmodified version of the file to effectively “undo” the changes as you can in other programs.  Changes to the structure of the database (field additions to tables and changes to forms, queries, and reports) will not be saved unless you save the file before you close it.

Create a New Table

Click on “New” and “Design View” and “OK.”  Add the following Field Names and (Types) to the table:  IDNumber (number), Preparation (text), Date (date/time), Time (date/time).  In the table below, select “Double” as the Field Size for IDNumber (it must be the same type as the IDNumber in the Subjects field so they can be linked later on.)  The “Double” type allows for decimal numbers (up to 10 decimal places) as well as whole numbers.  “Integer” allows only whole numbers.  Click on File and Save As, and then type in “Treatments” as the file name.  Answer “No” to the question “Do you want to create a primary key?” because you want to be able to enter multiple treatments for the same subject.  Close the Treatments table window.

Link the Tables using IDNumber

The ID Number field in the Treatments table must be linked to the IDNumber field in the Subjects table so that the entries in the Treatments table are associated with a particular subject.  In the top menu bar, click on Relationships [image: image2.png]s
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.  Hold the shift key and select both tables and then click on “Add.”  Then close the dialog box.  Select ID number (click with the mouse) from the Subjects table.  Drag and drop from the IDNumber in the Subjects table to the IDNumber in the Treatments table.  Select all the options at the bottom half of the dialog box and click on “Create.”  Your screen should look like this:
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The “1  (” type of relationship designates a one-to-many relationship in which multiple entries in the Treatment table can be linked to one entry in the Subjects table.  Close the Relationships Window and select “Yes” to save the relationship.  Now all of the entries in the Treatments table will be linked to a subject in the Subjects table when the same IDNumber is used for both the subject and the treatments.

Create a Data Entry Form

Under “Objects” in the main database window, select “Forms” instead of “Tables.”  Double-click on “Create form by using wizard.”  Make sure Table: Subjects is selected under Tables/Queries.  Click on “>>” to include all the fields from the Subjects table in the form.  Click on “Next.”  Accept the subsequent default options (Columnar, Standard) by clicking on “Next” twice.  Accept “Subjects” as the name of the form and Click on “Finish.”  You now see a data entry form for the first subject.  Click on Design [image: image4.png]Fle Edt View Insert Format Records Took Window Help
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 to modify this form.  Maximize or increase the size of the window if necessary to see the entire form.  Rearrange the fields on the form as follows:  Make the form wider by moving the cursor over the right edge of the gray area.  When the cursor appears as a cross with a horizontal arrow, drag the edge of the form to the right.  Select all the fields (with their labels) on the right side of the form by dragging the mouse over all of them (from one corner diagonally to the other corner).  Make sure you’ve selected all the fields you want and only the fields you want.  Then move the cursor over the selected fields; when the mouse cursor appears as an out-stretched hand, drag all these fields downward on the page.  Select the Date of Birth field and move it to the upper right part of the form.
Create a Validation Rule in a Form

Right click on the data entry part of the “EGA(L&D)” field and click on “Properties.”  Click on the “Data” tab if not already selected.  Under Validation Rule, type “>=19 AND <=44” without the quotation marks.  Close the dialog box.  This will prevent data entries outside this range when the form is used to enter data.  (Entries outside the range would be possible if the data were entered directly into the table.  This can be prevented if the validation rules are placed in the table, as above, rather than in the form.) For Validation Text (the error message you will receive if you violate the validation rule), type in “Enter a value between 20 and 44.”  
Create a Combo Box for Data Entry

Right click on the data entry part of the “Expired” field and select “Change to” and “Combo Box.”  Right click on the data entry part again and click on “Properties.”  Click on the “Data” tab if not already selected.  For Row Source Type, select “Value List.”  For Row Source, type in “Y”; “N” (include all of the quotation marks.)  Close the dialog box.  Select [image: image5.png]F2 Microsoft Access.
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  to view the modified form.  Your form should look like this:
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Click on the down arrow at the right of the Expired field to test your combo box.  Try to enter “56” as the EGA(L&D) to test your validation rule.  Save and close the Form.
Create a Query to Search for Missing data.

Under “Objects” in the main database window, select “Queries.”  Double-click on “Create query in Design view.”  Add the Subjects table to the query and close the dialog box.  Double-click on each of the fields in the upper part of the window to include them all in the query.  (Scroll down to see them all.)  For “Criteria” under DateBirth, type “is null” (without the quotation marks.  In the next row labeled “or,” enter “is null” under PlaceBirth.  This will search for any subject record that has DateBirth blank OR PlaceBirth blank.  If you put “is null” in the same row for each of these columns, the query would select only records with both fields blank.  Enter “is null” in a different row for each of the following fields: Race, Gender, EGA(L&D), Birthweight, CLD, DateDC/Exp, and Expired.  (Extend the dialog box down as needed by dragging the bottom edge down.)  Click on [image: image7.png]HMicosol access IR
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  to execute the query.  In the “Complete” column for each of these subjects, type “No” to identify these subjects as having missing information.  In Access (but not in all database programs), data changes and entries made to a query are stored in the table from which the query was derived.  Try typing “N” to test the validation rule you created before.  Save the query.  Click on File and Save As and name the query “Missing.”

Create a Query to select all inborn (PlaceBirth = 1) infants with RDS (1 = suspect, 2 = definite), sorted by whether or not they expired (Y = yes, N = no) and calculate the length of stay (DateDC/Exp – DateBirth)

Under “Objects” in the main database window, select “Queries.”  Double-click on “Create query in Design view.”  Add the Subjects table to the query.  Double-click on the following fields in the upper part of the window to add them to the query: IDNumber, DateBirth, PlaceBirth, RDS, DateDC/Exp, Expired, Complete.  The checkmarks for “Show” indicate that these fields will be visible in your query output.  For “Criteria” under PlaceBirth, enter “1” to select only inborn infants.  For “Criteria” under “RDS”, enter “1 or 2” in the same row to select only infants with suspect or definite RDS and born at hospital #1.  Click in the “Sort” box of the Expired column and click on the down arrow to select “Ascending.”  For “Criteria” under Complete, type “not “No” or is null” (only use the quotation marks around “No”) to eliminate incomplete records from the query.  Execute the query.  Your output screen should look like this (records may not be in the same order):
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This query selects the patients of interest and sorts them by whether or not they expired.  Save the query.  Click on File and Save As and name the query “RDS.”  

To calculate length of stay, return to the design view by clicking on [image: image9.png]Fle Edt View Insert Format Records Took Window Help
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.  In the first blank column, for Field, type “LOS:([DateDC/Exp]-[DateBirth])”.  “LOS” is the title for the column in the query output.  The brackets are used to designate field names.  Check the show box so that it will be visible in the output.  Run the query to verify that the LOS is calculated for each subject.

Calculate a mean for the length of stay for each of the survival (Y/N) groups.  Switch back to the Design view for the query.  Click on Totals ([image: image10.png][ Fo Gk i ot Query Tods Hindon b
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) on the menu bar at the top of the screen to add a Total row to the query.  In the query window, on the “Total” row, select “Where” for all of the fields except Expired since we want to group the data only by whether or not the subjects expired.  (Leave “Group By” for Total in the Expired column.)  For “Total” for “LOS,” select “Avg” to calculate the mean for this field.  Select “Show” only for the Expired and LOS fields.  Execute the query.  Your output should look like this:
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The mean length of stay is calculated for each of the survival groups.  Save the query.  Click on File and Save As and name the query “LOS.”  Close the query.

Create a report to list subjects after sorting by Race, Gender, and whether or not they had CLD (chronic lung disease).

Under “Objects” in the main database window, select “Reports” Double-click on “Create report by using wizard.”  Under Tables/Queries, select “Table: Subjects.”  Include IDNumber, Race, Gender, and CLD (chronic lung disease) in the report by selecting each one with the mouse and clicking on >.  Click on “Next.”  Select Race, Gender, and CLD as group variables for the report.  Click on “Next” then “Next” again (no sorting).  Select the “Stepped” layout and “Soft Grey” style.  Type in the name CLD for the report and Click on “Finish.”

Modify the report to count the subjects in each subgroup.

Open the Design view for the report.  Lengthen the CLD section by dragging the top of the bar underneath it (labeled Detail) down.  Open the Toolbox by clicking on [image: image12.png][ Microsoft Access.
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 in the Toolbox, then drag the mouse over part of the report window in the CLD section (make a rectangle in the bottom right corner) to create a text box.  Close the Toolbox.  Right-click on the unbound (right side) of the text box and select “Properties.”  Click on the “Data” tab.  For “Control Source,” type in “=Count ([IDNumber]).”  This will count the number of entries (number of different IDNumbers) in each CLD section.  Each CLD section has been grouped according to Race, then Gender, then CLD, so you will get a total count for each subgroup.  Close the dialog box.  Right-click on the left side of the text box, select “Properties,” select the Format tab, and type “Subgroup Total” in for “Caption.”  Use the mouse to resize the boxes by dragging the edges so that you can read all of “Subgroup Total” and the Count ([IDNumber]) box is narrow and lined up next to the Subgroup Total box.  Save and close the report.  (Click on “File” and “Save As”; accept the name “CLD” for the report.)  Double-click on the report to run it.  Your output should look like this:
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To receive credit for completing this module, you must email the database file (YourLastName-Exercise.mdb) to Deborah.Garcia@uth.tmc.edu.  Microsoft Outlook will block attachments with the .mdb extension, so you will need to zip the file before sending it by email.  You can do this in Windows XP by right-clicking on the .mdb file and selecting “Send To” → “Compressed (zipped) Folder”.  A compressed file with a .zip extension will be created in the same folder that contained the .mdb file.  You can then send the .zip file by email.
Other resources:

The Microsoft documentation that came with your software (under the Help menu) can be used as a reference for specific applications.  If you know what you want to do and what to call it, the Help functions can be very helpful in telling you how to go about it.

Other information from Microsoft can be accessed at www.microsoft.com/access.  Tutorials to perform specific applications and technical support are available at  http://www.microsoft.com/office/access/using/default.asp and http://search.office.microsoft.com/assistance/producttask.aspx?p=Access. A problem with the Microsoft site is information over-load.  It takes some time to figure out where things are.

Other tutorials are available on the Internet:

1. http://computing-services.cant.ac.uk/title/onlinetutorials/Access/index.htm (a reasonable introduction)

2. http://mis.bus.sfu.ca/tutorials/MSAccess/tutorials.html (more in-depth, requires downloading data files)
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